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DISClaImER

eliwell controls srl declines all responsibility for injury or damage deriving from the installation 
or use of this software other than for the purpose and in the manner described in this manual.
every care has been taken in preparing this document; however, eliwell controls srl cannot accept 
liability for any damage resulting from its use.
within the limits established by law, eliwell controls srl shall under no circumstances be held 
responsible for specifi c, accidental, direct or indirect damage (including but not restricted to 
damage resulting from loss or absence of earnings, interruption of activity, loss of data or any 
other economic loss) deriving from use of or failure to use this software product or from the supply 
of or failure to supply the associated technical support service, even in cases in which eliwell 
controls srl has been previously notifi ed of the risk of such damage. 

installation setup, software updates, reference libraries and documentation are also available from the 
restricted area of the website www.eliwell.it once you have registered.
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INTRODuCTION

GENERal DESCRIpTION
FREE Studio is a quick, effective development tool for creating and 
customising new programs for all types of iec application, which is particularly 
suited to Hvac/r requirements. 
the use of several different programming languages in accordance with 
IEC61131-3 regulations (programming standard for industrial control), makes 
it possible to develop new algorithms or entire programs totally unassisted, 
which can then be uploaded to 
• FREE Smart via pc or multi Function key 
• FREE Evolution via pc or usb 
guaranteeing the utmost confidentiality with appropriate security. 

COmpONENTS 
all basic components, interfaces, converters and accessories are described below[1].

FREE Studio software
the FREE Studio[2]  software suite and its functions will be illustrated in this document. 
the FREE Studio software suite consists of 4 development environments for programming the FREE Smart & FREE Evolution 
programmable controllers:
• FREE Studio application, dedicated to developers, for creating and managing libraries, iec applications and diagnostics
• FREE Studio Device, dedicated to users, for managing previously developed iec applications, downloading them to the 

target[3] device and modifying device parameters from a serial port.
the following 2 development environments are only available for FREE Evolution:
• FREE Studio Connection[4], dedicated to software developers, for creating networks
• FREE Studio user Interface, dedicated to software developers, for personalising the graphical interface on built-in 

terminals and remote terminals.

Dm Interface (DmI)
component required only for FREE Smart:
Component required for connection to pC
the usb/ttl-i2c hardware interface to be used in association with the software suite enables you to:
• use the software itself.
• connect to the target device in order to control it.
• connect to the multi Function Key (mFK) component.

The multi Function key (mFK)
component required for FREE Smart only:
this is a memory support, which allows you to:
1. update the firmware of the target device. 
2. update the iec application of the target device. 
3. update the parameter values of the target device.
4. download the parameter values from the target device.

Connection cables
components required for FREE Smart only:
• “yellow” cable with jst – molex terminals, see connection modes chapter for use instructions 
• “blue” cable with jst – jst terminals, see connection modes chapter for use instructions
• usb-a/a extension lead, 2 m

Converters
components required for FREE Evolution only:
• usb/485 adapter 
• usb/can adapter
note: alternatively if there is a RS232 serial port, Evolution can be connected to the pc using an rs485/rs232 adapter

1 the interfaces and converters are dedicated to Smart or Evolution.
2 Software suite or package. See abbreviations and definitions
3 programmable controller. See abbreviations and definitions
4 For Evolution only: Connection is the entry point of the software suite - see Target chapter
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abbreviations and definitions
• application, Device, Connection, userInterface: abbreviations of FREE (Studio) application, FREE Device, FREE 

Connection and FREE userInterface respectively. software suite
• IEC application: an application made to IEC61131-3 (industrial control programming standards) by means of the 

application development environment (tool) to be downloaded to the target using application or Device
• Target device, Target: name given to the FREE Smart or FREE Evolution programmable controller or “instrument”
• DmI: abbreviation of dm interface
• hmI: acronym of human machine Interface. Graphical interface developed with userInterface
• Instance: object of a predefined object class (function block, template, etc)
• IEC language: programming language to IEC61131-3 
• BIOS menu, BIOS: factory-set bios parameters menu. not modifiable[5]

• mFK: abbreviation of multi Function Key
• Quick Start: this document
• Smart: abbreviation of FREE Smart; Evolution: abbreviation of FREE Evolution
• Studio: abbreviation of FREE Studio. the software suite described in this document
• Tab. the work environment is divided into sections or panels. each panel may in turn be subdivided into tabs (e.g. 

resources tab)
• Template: in this document it denotes a page template created with userInterface
• panel or section: see Tab (e.g. project panel)
note: many definitions and abbreviations are standard information technology and/or plc terms and are not listed here
For example a Function is a standard term. other terms, such as Function Block, will be described in the relevant 
paragraphs.

ImpORTaNT: 
this Quick Start:
• is aimed at designers and developers and requires a knowledge of one or more iec61131-3 standard programming 

languages. 
• is designed to provide a first-level overview of the installation, functions and use of FREE Studio
• requires a reading of FREE Smart installation manual 9max00036 and/or FREE Evolution manual 9max00042 (x = 

0: it; 1: en; 3: es; 5: de) available in electronic format only (pdF) from www.eliwell.it subject to registration with the 
restricted area

• is available in electronic format only (pdF) from www.eliwell.it subject to registration with the restricted area

SySTEm RESOuRCES
the developer has the following resources available on the target devices for iec programming

Smart Evolution

Cpu 14.7 mHz
72 mHz, 32mb 

ram
available memory for 
application 190Kbyte 1mbyte

available memory for 
user Interface - 1mbyte

FlasH memory data - 126mbyte
ram memory* 2300byte 512Kbyte
ram memory* 1024byte 500 word
eeprom variables 1024byte 4000 word
* automatic mapping 
** modbus mapping

5 The BIOS cannot be modified but can be updated. 
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mINImum SySTEm REQuIREmENTS

OpERaTING SySTEmS

• windows xp Home sp2 or sp3 italian, english, spanish and German.
• windows xp professional sp2 or sp3 italian, english, spanish and German.
• windows 7 Home premium italian, english, spanish and German.
• windows 7 professional italian, english, spanish and German.
• windows 7 ultimate italian, english, spanish and German.[1].

OThER SOFTwaRE
(FREE Smart only)
driver at90usbxxx cdc usb to uart mGm for use of the dm interface[2]

see dm interface installation

mINImum haRDwaRE

• 1024x768 graphic resolution
• 700mHz cpu
• 1 Gb ram
• Hd with 5Gb of disk space
• 1 usb port[3]

• mouse or other pointing device.
• 1 cd-rw drive

note: a typical installation (available in english, standard libraries) requires about 500 mbyte of disk space. 
allow a further 1Gbyte of disk space for installing libraries and dedicated applications

to download the application, you need the following components:

FREE SmaRT haRDwaRE aND aCCESSORIES

• 1 FREE Smart SmD5500/C/S or a device from the FREE Smart family
• 1 DmI 100-3 manufacturer + yellow ttl cable[4]

• 1 optional mFK + ttl blue cable 
• FREE Smart power cables and transformer[5]

FREE EvOluTION haRDwaRE aND aCCESSORIES

• 1 FREE Evolution EvD7500/u or request the demo case (Demo Case)
• 1 uSB/RS485 or uSB/CaNOpen or plug-in Ethernet converter 
• 35va transformer for power supply to FREE Evolution

INTERNET

the installation set-up is supplied on cd-rw.
the installation set-up, software updates, libraries and documentation are also available from www.eliwell.it subject to 
registration with the restricted area (see technical support).
make sure an internet connection is available for access to software and manual documentation.

1 For all: other languages not explicitly tested
2 available in the installation package
3  For Evolution it is also possible to use a RS232 port by means of a RS232/RS485 converter 

For Smart (/S versions only) it is possible to use the RS232 port by means of RS232/RS485 converter with maximum speed 19200 baud. TTl 
cannot be used in this case.

4 see Connection
5 FREE Smart does not need to be powered separately if it is connected to a pC by means of DmI. use yellow TTl cable
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INSTallaTION

INSTallING STuDIO 

run EliwellFREEStudio_xxx.exe[1] supplied by eliwell and then follow the installation wizard as indicated in the following 
screenshots.

1. click 'Next'
2. click ‘I accept the agreement’[2]

3. click 'Next'. when installation is complete, the FREE Studio icon will appear on the desktop.

 

1 2 3

4. click 'Install'.
5. installation in progress
6. click 'Finish'.

 

4 5 6

applICaTION ICONS

click the FREE Studio icon on the desktop to access a folder containing the following links.
 

Evolution Evolution
icons

(links)
description

icons

(links)
description

 

application
development tool:

for Smart & Evolution

Connection
development tool

for Evolution

Device
development tool

for Smart & Evolution

user Interface
development tool

for Evolution

1 Check the software version in advance with Eliwell Technical Support
2  To continue with installation, you must accept the license agreement.   
 Carefully read the End user license agreement (Eula) before continuing.
 The Eula is also available on the website http://www.eliwell.it/content.aspx?id=4533
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TaRGET
the Studio software suite is designed for use with Smart and Evolution target devices.
the selection of the most appropriate target for the needs of the developer is indicated in the chapter Defi ning hardware 
Requirements.

FREE way
the Studio software suite is unique for Smart and Evolution.
the entire system is named FREE way: FREE Studio software + FREE Body hardware: Smart and Evolution.

FREE BODy: SmaRT
the Smart developer will only be able to use the application and Device work environments 
the Smart developer will be able to launch application to start programming.  
the Smart user can use Device to download the iec application previously compiled by the developer.
From application it will always be possible to open Device directly without having to launch the program using the FREE 
Studio icon.

FREE BODy: EvOluTION
the Evolution developer will be able to use all work environments.
the Evolution developer will be able to launch Connection to get started. Connection is the entry point for all development 
activities, from plc programming to creation of the Hmi menu and downloading onto the target using Device.
From Connection it will always be possible to directly open user Interface, application and Device without having to launch 
the relative program using the FREE Studio icon.

smart evolutionevolution
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INSTallING Dm INTERFaCE (DmI)[1]

CONNECTING ThE Dm INTERFaCE TO ThE pC
connect the dm interface to one of the usb ports on the pc. 
you are advised to use the supplied usb extension lead for the connection.

Dm INTERFaCE SETup
as soon as the dm interface is connected, the windows xp®[2] operating system installation wizard will start the installation 
procedure. the steps to be followed are described below.

1. on the initial page, select the “no, not this time” option and click on “next”.
2. set the second option as indicated and click “next”. 

the path you need to specify is the path of the program installation directory.
3. click 'next' and/or search for the indicated path with 'browse'. 

 

1 2 3

4. the operating system will prompt for confirmation to install the drivers. 
click on “continue”[3]

5. when the operating system recognises the device (driver) as “at90usbxxx cdc usb to uart mGm[4]”, click on “Finish”.

 

4 5

1 This operation must be carried out after installing Studio. Installation required exclusively for Smart
2 The same installation procedure applies to all other operating systems.
3 ignore the warning message about compatibility with windows Xp.
4 the file at90usbxxx_cdc.inf containing the driver is saved to C:\program Files\Eliwell\FREE Studio
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Reading the Dm interface COm port
Follow the steps below to check which com port the operating system has assigned to the dm interface.

1. click the right mouse button on the “resources” icon.
2. select the "computer management" option in the contextual menu.
3. click on "peripherals management" in the left window.
4. open the “ports (com & lpt)” options in the right window.
5. read the port setting at the end of the “at90usbxxx cdc usb to uart mGm” string or the string giving the dm interface 

data.
6. in the example shown in the illustration, the setting is:  com 3.

Changing the COm port setting
if there are contradictions, or for any other reason, another port can be assigned to the interface, as show in the illustration 
below.
• 1. right-click on the com port in question.
• 2. click on "properties".
• 3. select the port settings tab.
• 4. click on the advanced button.
• 5. change the com port number as desired.
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DEFINING haRDwaRE REQuIREmENTS

Small applICaTIONS

FREE Smart was designed for small plants and in particular for 

manufacturers of:
• a.t.u.s (air treatment units)
• chillers & Heat pumps
• rooftops
• compressor rooms  

Installers/integrators of:
• air systems
• Hydronic systems
• combi systems (air/water)

FREE SmaRT SElECTION CRITERIa
the FREE Smart models are available in both a din rail-mounted version, which significantly reduces wiring times, or in the 
regular eliwell 32x74 format for panel-mounting.

FREE Smart Smp has 2 models, giving you 6 digital inputs, up to 5 relay outputs, a triac output, 2 pwm analogue outputs, 3 
configurable 0…10v/0…20ma/4…20ma analogue outputs and an open collector digital output for an external relay. 

the standard eliwell 32x74mm format ensures versatility and ease of installation.  

FREE Smart SmD – SmC comes in a variety of models, giving you 6 digital inputs, up to 5 relay outputs, up to 2 triac outputs, 
up to 2 pwm analogue outputs, up to 3 configurable 0…10v/0…20ma/4…20ma analogue outputs and up to 2 open collector 
digital outputs for an external relay. 

the 4din format guarantees maximum flexibility and easy installation.

all inputs and outputs are independent and configurable, meaning they can be adapted to fit any system. 
it runs on 12-24v~ or 12-24v~/24vc power supplies. 

For further details, see the FREE Smart installation manual.

CONTINuITy wITh ENERGy FlEX[1]

FREE Smart inherits from the Energy Flex series the characteristics of the i/o and the electrical connections of the various 
models, to be combined with the corresponding expansions and keypads. the two platforms also use the same accessories.

FREE Smart also inherits the interface with modbus rtu serial communication standard from the Flex range and the option of 
downloading parameter maps and applications via mFK.

1 Note that continuity with Energy Flex DOES NOT include the applications. 
 The applications (e.g. air Treatment units) are developed by Eliwell and available for download from the site.
 visit the site and/or contact Technical Support for further details.
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SElECTING aN INTERFaCE

FREE Smart is available in 3 versions: smp for panel mounting and smd/smc for din rail mounting.

Smp 32x74 SmD 4DIN with display SmC 4DIN without display

the iec application created by application can be loaded on every version. 
menu navigation is identical for all models. 
the smp and smd models have a 7-segment, 4-digit led display. 
the smc model has no display so you need a remote terminal for configuration in the field. 
For a description of the keys, user interface and connections, refer to installation manual 9max0036[2] 

SElECTING OpTIONal mODulES
some of the accessories used by Smart are listed below: 

SKp 10 remote terminal 32x74 SKw22 remote terminal with lCD 
display without backlighting

SKw22l remote terminal with lCD 
display with backlighting

SKp22 remote terminal with lCD 
display without backlighting

SKp22l remote terminal with lCD 
display with backlighting

expansion modules (various models 
available) SE600 4DIN without 

display

2 (x = 0: IT; 1: EN; 3: ES; 5: DE)
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• the sKp 10 remote terminal for panel-mounting has the same interface as the main Smart module.
• the sKw22 remote terminal for wall-mounting has a dedicated interface with lcd display with or without backlighting. 

For further details, see installation manual 8max0218[3]

• the sKp22 remote terminal for panel-mounting has a dedicated interface with lcd display with or without backlighting.  
For further details, see installation manual 8max0218[4]

• the se600 expansion modules - available in various models - have i/o similar to those of SmD

For details of connections and further modules and accessories, see installation manual 9max0036[5]

COmplEX applICaTIONS
FREE Evolution was designed for medium and large plants and in particular for 

manufacturers of:
• a.t.u.s (air treatment units)
• chillers & Heat pumps
• rooftops
• compressor rooms  

Installers/integrators of:
• air systems
• Hydronic systems
• combi systems (air/water)

FREE EvOluTION SElECTION CRITERIa

EvD EvC EvE expansion module

FREE Evolution models are available in the 8 din rail-mounted version, with display (EvD model) or without display (EvC 
model), both supplied with removable screw terminals for quick and easy installation.

FREE Evolution EvD/EvC comes in a variety of models based on which you can mount 9 digital inputs, up to 7 relay outputs, 
5 confi gurable 0…10v/4…20ma analogue outputs 

the /u models are also equipped as standard with one usb port and one mini usb port.

The FREE Evolution EvE expansion module, without display, has the same format and the same i/o as the main module

the 8din format guarantees maximum fl exibility and easy installation.

all inputs and outputs are independent and confi gurable, meaning they can be adapted to fi t any system. 
24v~/c or 48vc power supply 

For further details, see the FREE Evolution installation manual. 9max0042[6]

3-4-5 (x = 0: IT; 1: EN; 3: ES; 5: DE)

Evolution
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CONNECTIvITy
the essential feature of Evolution is its versatile connectivity
the EvD/EvC models are all available as standard with canopen.
integrated rs485 or mpbus serials are also available as standard, depending on the model. 
each EvC/EvC model can be connected to 12 EvE expansion modules via canopen or rs485 serial.
integration into industrial systems, bms and ethernet networks is permitted thanks to the plug-in modules, available in 2din 
format, that connect quickly and intuitively to the main modules.
each Evolution can be connected to up to two remote terminals to view the integrated machine display. using the rs485 
network, a Smart system acting as a slave can be connected in a network in which Evolution acts as master.

EvK terminal EvK/N terminal EvS plug-in

the EvK terminal is available with canopen as standard. the EvK terminal can read menus from EvD/EvC
the EvK/N terminal is available with canopen, rs485 and etHernet as standard. the EvK terminal is fully programmable 
using the dedicated menu
integrated rs485 or mpbus are also available as standard, depending on the model. 
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the application work environment has various sections for developing the iec application, e.g. programming in 
iec 61131-3 compatible language, testing, debugging and iec application downloading to the target device.
N.B.: application only downloads the IEC application.  
parameters (BIOS and plC) and their default values are downloaded by Device and not by application.

the sections (panels) are listed below:

Section
panel /Section 

name

application
panel Description

a / Toolbars 

this section shows the work tools in the form of icons.
to display or hide the toolbars, simply right-click and 
select or deselect the desired tools.

some tools can be selected by means of key 
combinations (shortcuts). see relevant chapter for details

B / variables
the global and local variables of the code displayed in 
section D ‘Edit’ (programs, function blocks and functions) 
appear in this section

C

a

B

D

E

F

G

h

applICaTION paNEl DEFINITIONS
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Section
panel /Section 

name

application
panel Description

C project project

the project panel is divided into 3 tabs:
• project - for managing the application code
• Definitions - for managing and defining complex 

variables defined by the developer
• Resources - for managing the target device menu

D / Edit this section enables you to write the program

E watch Display variables with 
application running

this panel enables you to manage variables debugging 
by displaying their status in numerical format when the 
application is running and connected to the target device

F Oscilloscope Display variables chart

like the watch panel, this panel enables you to manage 
variables debugging by displaying their status in graph 
format when the application is running and connected to 
the target device

G library Functions library

this tool enables you to manage default functions 
libraries or functions libraries created by the developer.
the panel is divided into various tabs, one for each 
library. 
the tabs relating to the following are always available:  
• Operator and standard blocks: standard operators 

(and, or, etc)
• Target variables: specific variables of the target 

device
• Target blocks: specific functions of the target device
any additional tabs are managed by means of the drop-
down menu project > library manager

h Output messages

this panel shows the messages relating to the 
development of the project (file opening, compilation 
errors, status of connection to target device, etc.)
Note: the connection to the target device is also visible 
in the bottom right of the screen by means of coloured 
messages (see application download)

the panels appear or remain hidden (see Shortcuts) and can be organised as the user wants in terms of size and layout.
Studio saves the last settings made.

ICONS
the work tools are available via the drop-down menus or shortcuts.
panel a shows a series of icons that help the developer to create the application. 
the toolbars are displayed via the menu view > Toolbars
below are the most frequently used icons in the main and project toolbars.

main Toolbar

project Toolbar

the icons are self-explanatory. apart from the first few icons, which are very similar to standard icons (open project, save 
project, copy, paste etc.) there are icons with letters above them:
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Toolbar Function Function Shortcut

F main Full screen Full screen ctrl+u

w main workspace worKspace ctrl+w

O main
show / hide 

message panel
output ctrl+r

l main
show / hide 

 library panel
library ctrl+l

wa main
show / hide 

 watch window
watcH window ctrl+t

a main
show / hide 

 asynch graphic window
asyncH GrapHic 

window
ctrl+K

C project
compile

only selected project
compile F7

Ca project
compile all

compile all -

Co project connects to tHe tarGet
connects to tHe 

tarGet
F5

Dc project download code download code -

Ins project
insert record (variable, 

constant, alarm etc.)
insert record -

Del project delete record delete record -

project panel
detailed display of panel C / project[1]

project tab Definitions tab Resources tab

1 view for Smart
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GETTING STaRTED

FIRST STaRT-up[1]

1. click on the launch FREE Studio icon on your desktop
2. click on the FREE Studio application icon.

1 2

the program appears as shown in the picture:

you can now:
• create a new project ‘New project ...’
• open an existing project ‘ Open project …’ 
• open recent projects ‘Open an existing project ...’ by selecting from a list
existing projects have the extension .ppjs

the iec application is made up of one project and one or more programs written in iec code

1  The 'free Smart' logo at the start of this chapter indicates that the application tool is available for Smart. all tools (including application) are 
available for Evolution. For Evolution you are advised - for First Start-up and Creation of a new program - to always start from the Connection 
tool (see relevant chapter).
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CREaTING a NEw pROjECT

• click New project ... or
• select File > New project from the drop-down menu[2]

the dialogue box shown below appears, in which you can create, name and save a new project:

New project

the new project appears as shown in the figure:

• For a description of the icons, see Shortcuts
• a description of the programming languages is available in the Online help - see 'support'
• the panels in the standard development environment are described in the next chapter

the pages that follow explain how to create, develop and test a new application, with simple examples of libraries, function 
blocks and elementary programs.

2 The figure shows an example of a project for Smart. The same procedure applies for Evolution. Exceptions will be pointed out as appropriate. 
 however you are advised in this case to always start from the Connection tool and to follow the procedure described in the relevant chapter.
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CREaTING a NEw pROGRam[3]

project panel / programs Folder. 
right-click and select New program.
every project contains by default the program main

SElECTING ThE IEC laNGuaGE

the following dialogue box appears:

New program in ST language

select the desired programming language and enter a name.
the FREE STuDIO platform is compatible with all 5 standard programming languages (IEC 61131-3).

 . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

 . . . . . .

Init

Step0

SW1

 . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

 . . . . . .

Main Start

En1

En2

En3

N

/

 . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

 . . . . . .

MAX
In1

In2

ld  true
st  blinker.run
ld  true
st  blinker.run
cal trigger

ld  true
st  blinker.run
cal trigger

var2:=var2+1;
if  (var2=200) then
   var2: =0;
   var1: =not var1;

counter: =counter+1;
if  (DI2=TRUE) then
   out1: =counter and 5;
   out2: =counter and 7;
   out3: =counter and 12;
else
  

ST FBD IL SFCLD

each project may consist of several programs.
the developer may use one or more languages in the same project. each new program actually offers the choice of 5 
programming languages, 2 text-based and 3 graphics-based:
• ST, Structured Text language    text
• FBD, Functional Block Diagram language  graphical
• lD, ladder language    graphical
• Il, Instruction list language    text
• SFC, Sequential Function Chart language  graphical

OpENING aN EXISTING pROGRam

if the developer already has an existing iec application, simply open a .ppjs project from the menu File > Open project or 
select it from the list.

3 Creating a new program
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wRITING a pROGRam

in the Edit panel, write the program that you intend to develop.
the elements of the development tools are presented generically below.  
the appendix give some examples of simple programs which you can use to create a basic, functioning project.

pROjECT paNEl / pROjECT TaB

Creating local variables
using the drop-down menu, select variables > Insert (new record) or click on the respective icon
the variable appears in yellow in the central section, and you can define its characteristics by clicking on the respective boxes. 
where multiple choices exist, you can choose from a set of options by clicking on the three dots (…).  
a dialogue box will open 
• name
• type, to choose from one of the preset options or variables defined by the user (see picture)
• address: the default setting is automatic
• array: defines whether the variable is array type (if so, define its dimension) or not
• init value: initial value
• description

in the navigation tree below the program folder, the local variables will appear, identified by an icon 
note: local variables are NOT static

Creating a function block / function
in the same way as we create a program, it is possible to create 
• a function 
• a function block 
in the desired programming language.
note: creation of a function is available in 4 programming languages. SFC language is not supported for functions.

a function or function block is a (sub)program with inputs and outputs:
• a function requires n inputs and a single output (RESulT) with the same name as the function. the function's local memory 

is initialised each time the function is called
• a function block requires n inputs and m outputs. the local memory of each instance of the function block is kept between 

one call and the next (static memory)

each function or function block can be used within a program simply by dragging and dropping the icon in the Edit section of 
the program.

the function is used within the program by passing the input variables.
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the function block is used within the program as an instance in the same way as the declaration of a variable.

Example in ST language of call to function and function block

Creating global variables
the navigation tree contains the folder Global variables
From here you can create new
• Global variables
• mapped variables
• constants
• retain variables[4]

Shared global resources 
the shared global resources will appear in this section but will be defined in the Resources panel

4 not currently supported on Smart and Evolution targets.
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aSSOCIaTING a pROGRam TO a TaSK
For a program to run, it must be associated to a task.
there are various types of task:
• BOOT task runs once only at system start-up 
• Init. task runs each time the application is downloaded
• Timed. task runs at regular intervals which can be set by the developer. the default setting is every 100ms
• Background. task runs with low priority after the Timed tasks (between the end of one Timed task and the start of the 

next).  
Note each new project has the main program associated to the background task (the main program can still be eliminated 
and/or associated to other tasks).

to activate a task, go to the task you want, right-click and select add program

pROjECT paNEl / RESOuRCES TaB
the Resources tab enables you to define the eeprom parameters and status variables which may then be used in the 
application code (they will appear in the section project>Global Shared) and allows you to construct the menu prg 
(programming), the menu set status[5] and alarms of the FREE Smart / Evolution target as well as the interface of the current 
project, which will be displayed in FREE Studio Device

the Resources tab includes the following sections:

mODBuS OBjECTS
this section enables you to define eeprom parameters and variables, which can be displayed on the target, Device and read 
using the modbus® rtu protocol
For all sections, it is possible to add or remove parameters/variables in the same way as for variables in the project tab

EEpROm parameters

this section is for creating the variables which the developer intends to save even if the power to the target device is switched 
off. 
Note: the user of parameters in the code is read-only; to write, use the appropriate functions of FREE Smart.

Status variables

in this section we define the status variables which can be displayed in the menu of the target device.
each variable will have a transcoding on the instrument due to the 4 digit / 7-segment display.  in the display label box, you can 
select the transcoding and see a preview of how it looks on the display by clicking on the 3 dots (…)
Note: some letters will not be displayed (e.g. x and z) so there will be a blank space on the display. 
if the display label is zzz, nothing will appear on the display.
if the display label is SET, SEt will appear on the display.

5  only for Smart. See Installation manual 9max0036 (x = 0: IT; 1: EN; 3: ES; 5: DE)  
For Evolution the menu is defined from userInterface
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Evolution

EEpROm parameters

same as Smart

Status variables

in this section we define the status variables which can be displayed in the menu of the target device.

 Evolution

in the target column, only columns that are visible from the Smart or Evolution target are indicated. 
refers to both unless indicated

target column Description

Ipa pre-assigned index

address resource modbus® address

Name resource name which may be used by the developer in the iec 
application code

Smart display label name displayed in the application menu of the target (4-digit)

Device Type type of data displayed on target and Device

Default value /min/max minimum/maximum default values of the resource displayed on target 
and Device

Format display format of Default value /min/max
e.g. XXX.y display of integer with decimal point

application Type type of data used in iec application code

Scale/Offset conversion coefficients between Device Type and application Type
application Type = scale* Device Type + offset

Evolution Size significant only in the case of STRING type. dimension (length) of the 
string. default and max= 31 characters 

unit unit of measurement of Device Type displayed on Device and if 
available with icon on target

Smart access level see visibility table. this column does not apply to Evolution

Read only enables/disables editing of status variables.

Description/Note Free text displayed on Device
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Enums
in this section we define the types of additional variable which can be used in the Device Type column[6]

BIOS parameters
in this section we define any variations in the default bios parameters map which is factory-set by eliwell

TaRGET mENu
the target menu consists of a bios menu + an application menu
the bios menu is factory-set[7]. 
the tables below defines the main functions of the keys / leds of the target device

key press Description

F5 short switch from bios menu to application menu and vice versa

F1 or F3 short navigate folders and edit values

F2 short cancel operation (esc function)

F4 short access to set menu

F2+F4 short access to prg menu

F1/F2/F3/F4 long managed by developer (by means of target variable sysKeyFunctions[])

the leds are managed by the developer by means of target variable syslocalleds[])

prg menu[8]

in this section we define the prg menu and the folders/variables of which it is composed.
the prg menu can consist of one or more folders, defined by the developer, into which are inserted 
• eeprom parameters
• status variables
• bios parameters
• inputs and outputs

Set menu[9]

in this section we define the set menu and the folders/variables of which it is composed.
the set menu is created in the same way as the prg menu
the set menu contains the al folder - see below

visibility of menu resources
the visibility of the resources created by the developer is indicated in the following table:

access level column visibility on Device visibility on target Notes

always visible yes yes

object assigned to a prg or set 
menu

level 1 yes
yes 

level 1

level 2 yes
yes 

level 2

Never visible yes no

Never visible
yes

visible in the folder 
all paRamETERS

no object not assigned to any prg 
or set menu

alarms
it is possible to define alarm variables whose status must be managed by the developer.
if the variable assumes a value other than zero, the label will be displayed in the alarms folder (al) of the set menu in FREE 
Smart
in the Evolution target it is only a Global type uSINT declaration
6 see EEpROm parameters and Status variables table
7 see installation manual
8 the elements entered in the table in this section will be displayed on Device
9 the elements entered in the table in this section will be displayed on Device
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FREE Smart configuration
From the Resources tab, click on FREE Smart to access the following panel FREE Smart Configuration

using the drop-down menu you can set the value of the variable / parameter you intend to show on FREE Smart as the main 
display (Fundamental state display). if you set no value (none) the message plC will be displayed.
the values available are all the I/O[10] + the values defined by the developer in the Set menu

Execution time
From the same panel it is possible to set the execution time of the project in milliseconds (ms).
the default setting is 100ms. the available range is from 20ms to 100ms[11]. 

I/O mapping
in this section we define the links between variables and physical i/o of Free Smart.
• local: local variables of the smd/smc base module
• Extended: variables of the se expansion module
• Remote: variables on the sKw / sKp remote terminals

Evolution

TaRGET mENu
the target menu must be created by means of the userInterface. 
the bios menu is factory-set[12] and is visible from Device. 
the main functions of the keys / leds of the target device can be programmed by means of the userInterface[13]

menus
in this section we define a 'dummy' menu that does not appear on the display and the folders/variables of which it is composed.
the menu can consist of one or more folders, defined by the developer, into which are entered 
• eeprom parameters
• status variables

alarms
the alarms for Evolution are only defined to enable the portability of a Smart project

10 the I/O are all the local and remote inputs and outputs, including those of the remote terminals. See installation manual for details
11 also see Tasks
12 see installation manual
13 lEDs also programmable from application
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FREE Evolution configuration
From the Resources tab, click on FREE Evolution to access the following panel FREE Evolution Configuration

Execution time
From the same panel it is possible to set the execution time of the project in milliseconds (ms).
the default setting is 20ms. the available range is from 20ms to 100ms[14]. 

I/O mapping
in this section we define the links between variables and physical i/o of Free Evolution.
• local: local variables of the EvD/EvC base module
• Field: variables and/or binding of third-party controllers

Note
if correctly defined[15] all the variables defined in Resources will automatically be located in the Global Shared section.
 

14 also see Tasks
15 the project must be saved without errors for the variables to be visible in the project tab in Global Shared
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maNaGING pROjECTS

SavING pROjECTS

once you have completed the project you can save it in various forms and send it to third-party Developers or users.

File types

Target File type application Description

Smart .ppjS application project created with application to be opened with application

Evolution .ppjS application
Connection

project created with application that can be added to an Evolution 
device with Connection

.pll application library created by the developer to be used in application or Device

.RSm application compressed .ppjS project

Evolution .pajX user Interface project created with userInterface to be opened with userInterface

Evolution .ppjX user Interface as for .ppjs. compressed .pajX project

Smart .CFN Device project created with application to be opened with Device
note. the source code is not available but the project can be downloaded 
to the target device

Evolution .CFN Device project created with application or Connection to be opened with 
Device. if the device is created with Connection it contains both the plC 
application and the hmI menu
note. the source code is not available but the project can be downloaded 
to the target device

TRaNSFERRING pROjECTS aND FIlES

the table below shows several operations involving the transfer of projects from one developer to another or from a developer 
to a user. the data transfer involves the sending of one or more files defined in the previous section

project From -->To application File type Notes

the developer wants to transfer a project to 
another developer
the developer sends a .ppjs file 

the developer who receives it can open and 
edit it with Device application; the developer 
connects to the target, and compiles and 
downloads the application.

Developer


Developer

application .ppjS

the developer sends a .ppjs file to another 
developer 

the developer who receives it can open and edit 
it with application; the developer connects to 
the target device and compiles the application.
after compilation, the developer selects the 
menu heading Developer > Open with FREE 
Studio Device and configures the target device 
bios (parameterisation of the target device)

Developer


Developer

application
Device

.ppjS

the developer wants to transfer a project to a 
user
the developer sends a .cFn file
the user who receives it can open it with 
Device; the user connects to the target device, 
downloads the application and configures the 
target device bios (parameterisation)

Developer


user

Device .CFN From Device the user 
cannot compile the 
application
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project From -->To application File type Notes

the developer wants to debug an iec 
application already present on the target device, 
but does not have the source code.
the developer receives the entire project 
folder (which includes the binary files and 
debug symbols) used for downloading the iec 
application onto the target device.
Note: the project has not been edited (no 
change to source and no repeat compilation 
and/or download)

Developer


Developer

application project 
folder
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CONNECTION

to download the iec applications of Studio from the personal computer to the Smart target device, several additional modules 
are necessary.
the tables below show possible operations:

multi Function Key / DmI
pC          mFK

Multi Function 
Key

DMI

TTLUSBUSB

use the blue TTl cable for DmI - 
mFK connection

direction

Data downloading
 

parameter map - -

iec application  -

bios  -

multi Function Key 
mFK       Smart

Multi Function 
Key

TTL

free Smart

use the yellow TTl cable for mFK 
- target connection

direction

Data downloading
 

parameter map  

iec application  -

bios  -

Network
pC          Smart

free Smart
DMI

TTLUSBUSB

use the yellow TTl cable for DmI - 
target connection

direction

Data downloading
 

parameter map  

iec application  -

bios  -

note: in the case of network Smart must not be connected to earth

Evolution
to download the iec applications of Studio from the personal computer to the Evolution target device, several additional 
modules are necessary.
the tables below show possible operations:

uSB host
uSB     Evolution

direction

Data downloading
 

parameter map  

iec application  -

Hmi application  -

data archive - -

bios  -

uSB device
pC       Evolution

free Evolution

USBUSB

direction

Data downloading
 

parameter map - -

iec application  

Hmi application  

data archive  

bios - -

uSB-RS485 
uSB-CaNOpen

EThERNET
pC       Evolution

free EvolutionUSB/RS485

RS485USBUSB

free Evolution
+ Plug-in ETH

ETHERNET

direction

Data downloading
 

parameter map  

iec application  -

Hmi application  -

data archive - -

bios  -
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DOwNlOaD IEC applICaTION ONTO TaRGET

connection and application downloading operations for Smart and Evolution are different.
the connection procedures are illustrated below (see relevant paragraph) 
• network for smart 
• usb-r85 for evolution
the actual download adopts the same procedure for both targets

pRElImINaRy OpERaTIONS
in order to download the application correctly, the user must:
1. connect the dm hardware interface to the pc.
2. make sure that the driver has been installed - see dm interface set-up.

COm settings[1]

From the drop-down menu, select Communication > Settings
the com port must previously have been read/set in “peripherals management” (see reading the dm interface com port) for 
it to be recognised. if there are errors, refer to the paragraph “Dm interface connection error”.

For Smart select EwDmI or modbus[2]. if the protocol is not activated press the activate button
the value selected for the com port will be saved and will reappear each time the program is accessed, until it is changed. 
the properties are visible and can be edited from the panel Communication > Settings > properties[3]

1 the COm settings must be set on all of the work environments: application, Device and userInterface
2 in the case of modbus for /S models only with maximum speed 19200 baud. TTl not for use.
3 obviously, the protocol must be activated beforehand
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Dm interface connection error
error opening serial port
if the "error opening serial port" message appears, proceed as follows:

1. check that the com port setting in the program is the same as one read in the com port reading by the Dm interface.
2. if they are the same, physically disconnect and reconnect the Dm interface from the usb port. this should make the 

operating system recognise the interface.
3. repeat the DmI detection function.

SmaRT TaRGET
Smart has certain parameters in the cF folder for managing the connection between the target and Studio

if the target is 'empty'[4], e.g. there is no IEC application on the device, Smart will display the message FrEE:

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

to view the parameter menu, press the 
esc and set keys at the same time. this 

will open the par menu.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

the parameters menu par contains all 
controller folders. press the set key to 

view folders.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

the first folder shown is the cF 
configuration folder. press the set key 

to view the folder parameters.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

the first parameter shown is cF30. to 
view the value of the parameter press 

the set key.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

use the up and down keys to change 
the value if necessary. to confirm the 

value press the set key.
to exit press esc

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

use the up and down keys to scroll 
the other parameters and repeat the 
procedure to view the values and - if 

necessary - edit them. 

parameters needed for correct connection between the Smart target and Studio.[5]

parameter description values default visibility notes

CF01 select com1 (ttl) protocol
0 = eliwell

1 = modbus
1 2 must be set to 1 

CF30 modbus protocol controller 
address

1...255 1 3

check that the set 
values correspond to 
those defined by the 

panel 
Communication > 

Settings > properties 

CF31 modbus protocol baud rate

0,1, 2 = not used
3 = 9600 baud

4 = 19200 baud
5 = 38400 baud
6 = 5700 baud

7 = 115200 baud

3 3

CF32 modbus protocol controller 
parity

1= even
2 = none
3 = odd

1 3

4 otherwise (IEC application exists on Smart) the message plC will appear on the display. 
 Simultaneously press the up and DOwN keys to view the message FrEE
5 for other parameters and to manage visibility levels see the Smart installation manual
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Evolution

COm settings[6]

the settings are identical to those given for Smart:
panel Communication > Settings 
For Evolution EwDmI must not be selected

• select CanOpen in the case of usb/can connection
• select modbus in the case of usb/rs485 connection
• select modbus TCp in the case of ethernet connection using the relevant plug-in

if the protocol is not activated press the activate button

also in this case, the properties are visible and can be edited from the panel Communication > Settings > properties
 Communication > Settings > properties[7]. the panel displayed depends on which protocol is activated:

CaNOpen modBus modbusTCp/Ip

EvOluTION TaRGET
Evolution has a number of bios parameters for managing the connection between the target and Studio but, unlike Smart, it 
does not have a default menu shown on the on-board or remote display.[8]

therefore in order to view the parameters you need to open Device
parameters needed for correct connection between the Smart target and Studio[9]:

the two protocols available on-board are shown. For the protocols available on the plug-in module, see the installation manual

6 the COm settings are valid on both application and Device
7 obviously, the protocol must be activated beforehand
8 Eliwell provides examples of hmI menus for configuration of BIOS parameters
9 for other parameters see the Evolution installation manual
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On-board RS485 

parameter description values default notes

Baud_RS485_OB
on-board modbus 

protocol
baud rate

0=9600 baud
1=19200 baud
2=38400 baud 
3=58600 baud
4=76800 baud

5=115200 baud

2

addr_RS485_OB on-board rs485 serial 
address 

1...255 1

the actual address is 
determined by the sum 
of this value + the value 

of the dip switch

proto_RS485_OB
on-board rs485 

protocol selection
2 = unet

3 = modbus/rtu
3

Databit_RS485_OB on-board rs485
data bit number

8 Fixed at 8

Stopbit_RS485_OB on-board rs485 stop 
bit number

1= 1 stop bit
2= 2 stop bit

1

parity_RS485_OB on-board rs485 
protocol parity

0= null
1= odd
2= even

2

On-board CaN 

parameter description values default notes

Baud_CaN_OB
on-board can 

protocol
baud rate

2=500 Kbaud 
3=250 Kbaud
4=125 Kbaud
5=125 Kbaud
6=50 Kbaud

2

addr_CaN_OB on-board can serial 
address 

1...127 1

the actual address is 
determined by the sum 
of this value + the value 

of the dip switch

CONNECTING TO ThE TaRGET
before connecting, the bottom right of the screen displays the message NOT CONNECTED
From the drop-down menu select Communication > Connect

if connection is successful, the following screen (minimised) appears in the menu bar:

this screen will remain present as long as the target device is connected. to interrupt the connection, repeat the 
Communication > Connect procedure

at the bottom right of the panel is a connection palette divided into 3 sections
before connecting to the target the panel shows that there is no connection

when connected to the target there are various situations shown below

• CONNECTED (in green): if the connection is established and the target application coincides with the Studio application
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• CONNECTED (in yellow): if the connection is established and the target application does not coincide with the Studio 
application

• CONNECTED (in green): if the connection is established
• NO CODE (in light blue): if the connection is established and there is no application on the target

• CONNECTED (in green): if the connection is established and the target application coincides with the Studio application
• SOuRCE OK (in green): if the connection is established and the target application coincides with the Studio application

• ERROR (in red): if there is a communication error

DOwNlOaD
to download the application, simply press F5 or select Communication > Download code from the drop-down menu

the following dialogue boxes will appear

a. if the application is already present, you will be asked for confirmation to overwrite the previous version

B. warning message that the plc will be reset on the target

if you confirm with ‘yes’ the application will be downloaded to the target. the process may take a few seconds: the ‘Download 
in progress’ window appears to show the status of the download.

in the event of a connection error, the following dialogue box appears:
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the Device work environment is shown below with screenshots and descriptions for Smart. where necessary, 
the differences compared to Evolution are highlighted.
the Device work environment has various sections for managing an iec application generated by a developer, e.g. FREE Smart 
parameter configuration, testing, bios updating and application downloading to the target device.
Note: the source code of the application is not visible from Device

the sections (panels) are listed below:

Section
panel /Section 

name

application
panel Description

a /
Configurator bar 

 

this section shows the work tools in the form of icons.
to display or hide the toolbars, simply right-click and 
select or deselect the desired tools.

some tools can be selected by means of key 
combinations (shortcuts). 
see relevant chapter for details

applICaTION paNEl DEFINITIONS

a

CB

GF

D

E

h
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Section
panel /Section 

name

application
panel Description

B project project
the project panel enables you to manage one or more 
FREE Smart devices.

C / Edit panel

according to the selection made in the project panel, the 
following appear in this section:
• bios parameters (parameters + i/o values)
• parameters and variables defined by the developer in 

application associated to the menu

D Catalog applications catalogue this panel shows all the applications available from the 
catalogue

E Connection 
Status

this panel shows the connection status of all the targets in 
the project panel

F watch Display variables with 
application running

this panel enables you to manage variables debugging 
by displaying their status in number/letter format when 
the application is running and connected to the target 
device

G Oscilloscope Display variables graph

like the watch panel, this panel enables you to manage 
variables debugging by displaying their status in graph 
format when the application is running and connected to 
the target device

h* Output messages

this panel shows messages relating to the development 
of the project (file opening, reading/writing errors, status 
of connection to device, etc.)
Note: the connection to the target device is also visible 
in the bottom right of the screen by means of coloured 
messages (see application download)

*panel not visible at first start-up.  
to display it, simply check the heading in the drop down menu view > Output

the panels appear or remain hidden (see Shortcuts) and can be organised as the user wants in terms of size and layout.
Studio saves the last settings made
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FIElD OpERaTION

FIRST STaRT-up[1]

1. click on the launch FREE Studio icon on your desktop
2. click on the FREE Studio application[2] icon.

1 2

the program appears as shown in the picture:

you can now:
• create a new project .CFN ‘New project ...’[3]

• open an existing project ‘ Open project …’ 
• open recent projects ‘most recent projects ...’ by selecting from a list

Device projects have the extension .CFN
in the same project, you can add more than one drive and associate to each drive an iec application created with application

1  the Device tool is available for Smart. all tools (including application) are available for Evolution. For Evolution you are advised - for First Start-
up - to always start from the Connection tool (see relevant chapter)

2  a project can also be opened with Device from application from the drop-down menu Developer > Open with FREE Studio Device

3 for a new project, you must add a drive listed in the catalogue by right-clicking and selecting add. See screenshot
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a new untitled project is empty. simply right-click to add a new drive to the existing project in the catalogue by selecting add. 

OpENING ThE IEC applICaTION

in the same way you can add the respective plC iec application present in the catalogue.
the catalogue can contain various applications but only one can be associated to a project
the iec application will be added to the drive with name_1

existing projects can be opened as described previously or directly from application:
the menu Developer > Open with free Device will start the Device containing the project created by the developer with the 
development environment application
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CONNECTING TO ThE TaRGET DEvICE

Device requires you to connect to the target device again (click on the respective icon). the central panel shows the 
protocol references, address, etc. the default name of the target device is Freesmart_1[4].
when the target device is connected, you can read or write parameters 

REaDING paRamETERS[5] 

by default, the project contains a list of the bios parameters and i/o values[6] with their respective default settings.
From the target device, the user can read all or just some of the parameters[7]

suppose we want to read all the parameters.
From the drop-down menu parameters>Read all device parameters it is possible to read all the parameters of the connected 
target device.
the operation takes a few seconds.

if there are configuration parameters which have default values other than those present on the target device, they will be 
highlighted in an appropriate colour (blue[8])

wRITING paRamETERS 

the user can download all or some parameters to the target device, either with their default values or with modified values 
inserted by the user

suppose we want to download all the cl parameters (local bios) and no others. 
select all the parameters - drop-down menu parameters>Select all (ctrl+a) or using the respective icon. the parameters are 
all highlighted in yellow.  write drop-down menu parameters>write selected (ctrl+sHiFt+w) (or using the icon w)
all the cl parameters will be downloaded to the target device[9].

as explained in the notes, you can also download the values of the i/o variables set by the user or their default values.

4  by simply using the copy/paste function, you can create a twin project FREESmart_2, change the BIOS parameters and download them to the 
target device or a second target device

5  in reality, in this case, the term 'parameter' refers to any resource present on the target device, in other words genuine parameters in their own 
right, I/O and variables of the application present on the target

6 the default value of the analogue inputs and outputs is 0.0; the digital inputs and outputs are set to FalSE
7  to read a parameter, simply select it with the mouse and click on the icon R. 
 multiple selections are permitted (CTRl for non-consecutive selections, ShIFT to select part of the block)
 you can select the entire block by clicking on the respective icon
 The selection is highlighted with a yellow background
8 see parameter values table
9 see the specific chapter containing project development examples 
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downloading all the parameters (drop-down menu parameters>write all device parameters[10]) replaces all the values 
present on the target device with the values listed in the value column.
Note: the inputs are read-only and are shown in grey. see the following table:

parameter values table

colour column description cases

black value value aligned with default target already read

blue default
default column value different 

from value in value column
target already read

red value
value not aligned with 

default • Device just opened
• value changed by user

grey name read-only parameters 
i/o values

analogue inputs ai and 
digital inputs di

green name
parameters not visible on 

target display
see visibility table

 
when declaring the status variables and eeprom parameters in application you can also define their level of visibility in the 
Smart target[11] menu as shown in the figure:

BIOS Download
the user can also upgrade the Smart BIOS from device. select the name of the target and click the right mouse button. select 
BIOS download[12] and open the .fwf file that you want to download
the Direct mode is executed via DmI directly on pc whereas the multiFunctionKey mode requires passing through mFK and 
then downloading onto Smart

Evolution

the default bios menu of Evolution is visible from the folder all parameters.
in the all parameters folder you can also view user parameters defined with application 
downloading the plC application and the hmI menu is only performed from Device but is described in the Connection 
chapter 

10 if you select parameters>write all default values, all the default values including I/O will be downloaded to the target device
11 has no effect on Evolution
12 see installation manual. BIOS Download not available via RS485. 
 Do NOT power up Smart externally (only power up via DmI)
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DEFINITIONS OF uSER INTERFaCE paNElS

the user Interface work environment dedicated to developers features various sections for creating and 
managing customised pages, e.g. defining the graphical interface of FREE Evolution, using and creating 
templates and downloading hmI onto the target device.

the sections (panels) are listed below:

a

CB
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D E

h
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Section
panel /Section 

name

user Interface
panel Description

a /
Configurator bar 

 

this section shows the work tools in the form of icons.

some tools can be selected by means of key 
combinations (shortcuts). 
see relevant chapter for details

B project project

the project panel is divided into 2 tabs:
• project: for managing the pages that will be shown 

on the Evolution graphical terminals
• Resources: for managing images, lists and strings 

that may be used in the pages

C actions

according to the selection made in the tab, the following 
appear in this section:
• local actions
• Global actions
actions linked to the user interface keys

D Document bar Edit panel this panel is used to configure the graphics of the pages

E properties view properties this panel is used to define the properties of the pages or 
of their constituent elements

F Output messages this panel shows messages relating to the development 
of the project (file opening, compilation errors, etc.)

G Target vars & 
parameters

view target variables and 
parameters

the panel is divided into 2 or more tabs:
• Target vars contains the variables/bios parameters 

of Evolution
• plC vars contains the variables/parameters defined 

in the plc application of application installed in 
the evolution base module where the hmI will be 
downloaded.

• other tabs display variables/parameters with modbus 
address to be shown on the Hm interface. note: 
these applications have been downloaded using 
studio onto other Evolution modules connected in 
a network to the Evolution onto which the Hmi that 
you intend to develop will be downloaded

h Templates view available templates this panel shows all of the pages created as 'templates', 
e.g. as reusable models available in the catalogue

the panels may be visible or hidden at first start-up.  
to view them, simply check the relative heading in the drop-down menu. For example: view > Templates
the panels can be organised as the user wants in terms of size and layout.
Studio saves the last settings made.
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TO STaRT uSER INTERFaCE

uSERINTERFaCE vS CONNECTION

as already mentioned in the TaRGET chapter and as described in the Connection chapter, userInterface is typically opened 
from Connection by clicking on the Hmi node 
you are therefore advised to read the Connection chapter before developing a menu in userInterface
to get started and create a simple stand-alone menu[1] follow the outline illustrated below

FIRST STaRT-up

1. click on the launch FREE Studio icon on your desktop
2. click on the FREE Studio user Interface icon.

1 2

the program appears as shown in the picture:

you can now:
• create a new project ‘New project ...’  - CTRl+N
• open an existing project ‘ Open project …’ - CTRl+O
existing projects have the extension .pajx

1 a menu created in this way is subsequently linked to a Connection project. See corresponding chapter.

Evolution
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CREaTING a NEw pROjECT

• click New project ... or
• select File > New project (CTRl+N) from the drop-down menu

the dialogue box shown below appears, in which you can create, name and save a new project:

New project

the new project appears as shown in the figure:

• a description of the icons is available in the Online help - see 'support'
• the standard development environment described previously is developed in this chapter
the pages that follow explain how to create, develop and test a new menu, with simple examples of pages, templates and 
elementary programs.
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CREaTING paGES

all of the created pages that will comprise the menu shown on the instrument display will appear in the Document bar panel.
the elements for creating pages are presented generically below. 
the appendix gives some simple examples of menus that you can use to define a basic, functioning menu.

pROjECT paNEl / pROjECT TaB

in this tab the following elements (nodes) can be used:
• pages for managing pages (create, delete, import/export etc.)
• messages for managing message pages
• Global variables  for managing 'variables' common to all pages
• Global procedures  for managing 'procedures' common to all pages. note: procedures are written in st language only

paGES

properties
From the project tab, pages node, by right-clicking on properties you can edit the properties of[1] pages as indicated:

General System options language selection

1. From the General tab you can select which page to set as the initial page
2. From the System options tab you can select the type of font[2], the text colour and the background colour (choice of black 

or white)
3. From the language selection tab you can manage the language settings: 
 • click Select to choose the current language (indicated in the Current language box), 
 • click add to add a new language
 • click Delete to delete a language
 • click Export to export and import the .txt text file to be translated[3]

• click Import to import the translated .txt text file[4]

4. from the tab Global On timer the developer can add specially created global 'on timer' procedures

Creating pages
using the drop-down menu, select project > Objects (insert page) or click on the respective icon New page 
a window will open where you can insert the name of the page[5]. the created page appears in the Document bar section 
(where it can be edited and changed)
note: the page can be set as a pop-up page[6]

1 these properties are not those of the individual page but are common to all pages
2 also visible from the tab Resources > Fonts
3 and from the drop-down menu project > Export language to file...
4 and from the drop-down menu project > Import language from file...
5  the page name must not contain spaces (e.g. New page returns an error; Newpage (with no spaces) or New_page (with underscore) are 

acceptable names. No other characters are accepted (E.g. /, <,>, etc)
6 only one page is shown on the display at any one time. a pop-up page is a page that is appears on top of another page 



FREE Studio - Quick Start  page 44

Initial page
the property of 'initial' page must be assigned[7]

the initial page can be the page used for the 'fundamental state display' e.g. the default page that appears when the  
instrument is not in use. the fundamental state display can therefore be an image[8] (e.g. logo or company name) or a page that 
displays important values (e.g. temperature, pressure, setpoint etc.) for easy reference.
note: if the initial page is not set, a compilation error will be returned.

managing pages
click the right mouse button to rename, copy or delete a page, etc.

Insert page New page

messages
From the project panel, right-click the messages node and select Insert new message page to create a new message page[9].
message pages are similar to other pages but each one bears a unique ID

message page example of message pages tree example of message 1 page 

Template
From the project panel, by right-clicking on a page you can export the page (ending in .pex), or select Export page as 
template to save the page as a template page[10]. (ending in .petx)
From the drop-down menu project > Template management you can manage templates by adding .petx pages to the 
Template list. the added pages will also appear in the Templates panel as a library and can be used by dragging and 
dropping them in the project, creating the desired template from time to time.

7 it can be modified from the pages section (node). The initial page is identified by a 'play' icon (red triangle).  
8 technically known as a 'splash' 
9 identified in the tree as a warning triangle on a yellow background
10 a template is a model or form that must be compiled based on a predefined structure
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Template list Template library Instance of a template page

pROpERTIES paNEl 
every object that will be drawn on the page has properties that can be set from the properties tab.
depending on the object selected from the page bar in the properties tab, the elements required to correctly manage the 
object on the page will be shown or hidden
the complete list can be consulted in the Online help. the most frequently used ones are listed here.

pROpERTIES TaB[11]

each individual page has properties listed as follows:

Default Description Default Description

chardimx 6
defines the 

'guides' of the 
page grid

min(1,1) for 
positioning 

objects

title bar no
inserts a title with a 

preset width

chardimy 8 page border no
inserts a page 

border

Font ewp2_8x16 character size caption *
defines the content 

of the title bar

back color 'white'
background 

colour
appearance Flat

defines the page 
border

text color 'black' text colour

each time that these fields are modified, an asterisk (*) appears next to the name of the page.
to save the change, always use the return key.

aCTIONS paNEl 
this panel enables you to define the 'actions' assigned to the Evolution keys for navigating the menu on the display.
actions are divided into 
• local actions: actions that are specific to the individual page concerned
• Global actions: actions that are common to all pages in the menu/project
Evolution has 4 keys: right, left, up, down and enter. you can also associate an action to a long press of each of the 4 keys[12] 
(identified by the prefix long, e.g. longup).

in addition to the 4 keys there are 10 virtual keys identified with vK_F1, ..., vKF10[13]

the virtual keys are associated to a procedure written in ST language

11 do not confuse with the corresponding item 'properties' in the project tab, pages section (node)
12 long press of about 3-5 seconds
13 also see userInterface manual (Online help)
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For example, suppose that we want to set the time of the rtc clock. we create the relative page

 
we associate the page to a virtual key vK_F1 (Close) in local actions.
the procedure in ST language is as follows:

sysClock_update := TRUE;
uint_ret := Video_SendEvent[14](kWM_KEY,kKEY_vK_F1);

to insert an action, click the right mouse button and select Insert action. the selected action is highlighted yellow. selecting 
Remove action will delete the action highlighted in yellow
each key can be associated to the following actions

action column Description Notes

call call of a procedure
to call a procedure simply write in the 
link column the name of the procedure 
you want to call

openpage opens a page
write in the link column the name of the 
page you want to open

close closes the page
pair with the relevant key. note: 
automatically returns to the start page

nextField moves to the next value in a field

prevField moves to the previous value in a field

edit
enables you to edit, e.g. write a value in 

a field 

14 the standard functions predefined as videoSentEvent, etc. (to be handwritten) are described in the userInterface manual
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applICaTION FIElDS
From the menu project > parameter management[15] you can link the parameters of an application developed in 
application 

click add Device to import the desired parameters file (.parx). modbus or ewdmi addressing can be associated to each set of 
parameters.
the set of parameters will be shown in the appropriate tab of the Target vars and parameters panel

plC vaRIaBlES

From the menu project > parameter management you can link the variables of a plc application developed in application 

import the desired 'exp variable' file (.exp). the set of parameters will be shown in the relative plC vars tab in the Target vars 
and parameters panel

GENERaTING DOCumENTaTION

using the icon Generate Doc. you can create documentation linked to the Doc fields (properties panel, Doc tab)

through a browser[16] you can view the generated documentation by clicking on the link open documentation.
the documentation gives all information relating to the project:
• number of pages
• program languages
• initial page (name of initial page)
• visual list of pages (as they are presented on the display)

15 or from the corresponding parameter management icon
16 Internet Explorer or equivalent
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example of documentation generated using the icon Generate Doc. 

pROjECT paNEl / RESOuRCES TaB
in this tab the following elements (nodes) can be used:
• Fonts for managing pages (create, delete, import/export etc.)
• Bitmaps for managing images to be inserted in the pages
• String table for managing strings to be used in the various pages
• Enumeratives for managing enumerable sets to be used in the various pages
• Image lists
• Sets for managing sets of strings / parameters to be used in the various pages

Bitmaps
userInterface can be used to import images (specifically bitmaps, such as icons, logos etc.) to be used in the menu pages.
click on the node Bitmaps > Import bitmap. the corresponding window appears for importing the image. click the browse 
button to select the image and the import button to import it. example of import of free logo.

we recommend that you import black/white images of suitable size. the display can support an image of approximately 
100x50px. the imported bitmap will be in the Bitmaps node[17]

to insert the bitmap in a page:
• insert an 'image' box (menu page > new image or use the corresponding icon)
• define the dimensions of the image from the properties panel using XDim and yDim (e.g. 100x50px)
• again from the properties panel select the bitmap from the field of the same name

17 if not renamed it will be assigned a default name consisting of the image name preceded by the prefix bmp (e.g. logofree-> bmplogofree)
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String table
userInterface allows you to define strings that can be used when creating pages.
using the menu String>Insert or the respective icon Insert Record you can create an association[18] between a string and its 
corresponding description. 
in the ID field the string is defined as IDS_stringname. [19]

in the Caption field enter a description of the string.

by selecting the page from the menu project/project you can associate the desired string to a text field using the menu 
properties>Caption[20]. the text that will appear on the display will be the text inserted in the description.[21] 

Enumeratives
userInterface also allows you to define strings by means of enumerable sets that can be used when creating pages.
an enumerable set is an array of values that are not necessarily consecutive. each value is associated to a description that will be 
shown on the Evolution display. 
move onto the Enumeratives node and use the menu Record>Insert or the respective icon Insert Record to create the sets 
that you want to use[22] 
each set will be shown as a subnode of Enumeratives. 
move onto the corresponding node and use the menu Record>Insert or the respective icon Insert Record to enter the array 
values 
after creating (or defining) the enumerative from the Resources tab, open the project tab and, selecting the page / element of 
the desired page, you need to associate the corresponding Enum to the Format field
the three examples show 
• definition of an enumerative CelFarEnum consisting of 2 values for defining the degrees of temperature (0=celsius, 

1=Fahrenheit). 
• definition of an enumerative consisting of 4 non-consecutive values for defining usb commands (values 8,9,10,12)
• use of CelFarEnum on a page

the order of the elements can be changed with the icons move up s / move Down t

18 technically referred to as 'transcoding'
19  you are recommended to use this prefix to prevent the descriptions that appear on the display being confused with the transcoding in 

userInterface
20 in practice it is also possible to associate images but for the sake of simplicity we have only dealt with text fields here
21 if the Description field is empty, the string IDS_xxx will appear
22 the default name is Enum1, Enum2, etc. Select the box to change the name 
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definition of CelFarEnum Enum with non-consecutive values use of CelFarEnum

Image lists
similarly to Enum it is possible to create lists of images associated to ranges of values. the image shown on the display will 
change depending on the state of the variable associated to the list.
a list is created and a bitmap (see corresponding node) is associated to each image, indicating its reference range.
after creating (or defining) the list from the Resources tab, open the project tab and, selecting the page / element (created with 
'New animation') of the desired page, you need to associate the bitmap list to the imagelist field
the three examples show 
• definition of a modeimg list of 2 bitmaps for displaying cool mode and Heat mode. the range of values is reduced to one 

value in this case (0 for cool, 1 for Heat)
• use of modeimg on an 'icons' page, associating the modeimg list with the animation. a state variable must obviously be 

associated, depending on which the image will change
However a static bitmap must be inserted as an image via page > New Image or using the respective icon

definition of modelmg use of modelmg

Sets
often there is the need to create a group of very similar pages (for example a scroll menu for showing a set of parameters in the 
same folder)
userInterface allows you to define sets that can be used when creating this type of page, without having to replicate the page 
n times.
a set is an array of strings or variables/parameters[23]

move onto the Sets node and use the menu Record>Insert or the respective icon Insert Record to create the sets that you 
want to use[24] 
the type of set can be 
• String e.g. a string defined in a string table
• variant e.g. a variable/parameter

each set will be shown as a subnode of Sets. 
move onto the corresponding node and use the menu Record>Insert or the respective icon Insert Record to enter new items 
in the array 

23 including any alarms
24 the default name is Set1, Set2, etc. Select the box to change the name
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Strings
in the case of a String type Set the string is selected by moving onto the box and clicking on the three dots (...)
the Resource string selection window appears, which shows the available strings[25] that can be associated to the array
the visibility (visible column) for strings is true - not modifiable

variant
in the case of a variant type Set, the variable is selected[26] in the same way by moving onto the column variable/parameter
the variable/parameter selection window appears, which shows the available variables that can be associated to the array

using the Filter option you can filter the display of the variables/parameters

• the Format column shows the default u.m. of the parameter. the user can manually associate an Enum
• similarly the min max columns show the default range of the parameter, which can be modified by the user[27]

• the Text align column aligns the string to the left, right or centre.
• 
after creating the set from the Resources tab, open the project tab
previously a page was created that you want to replicate using Sets
(for example in order to manage the analogue outputs BIOS_CFG_aO)
selecting the appropriate field, you need to associate the corresponding set to the field assoc_var using the prefix #, and with 
the suffix (0) to indicate the first element of the array. note: the field must be of the Edit type
(for example in order to manage the analogue outputs #SetparvalCfga0(0))

the three examples show 
• definition of a variant set SetparvalCfga0 of size 5 to define array of output configuration parameters  
• definition of an enumerative anaOutTypeEnum of 3 values (voltage, current, on/oFF)
• use of #SetparvalCfga0(0) on a page (which results in the production of 5 pages that differ in terms of the configuration 

of parameter SetparvalCfga0(1),..., SetparvalCfga0(5)[28]

• note that the edit field 'io modulated' is associated by means of the Format field to the enumerative anaOutTypeEnum

note that in the example there is another edit field associated to a Set. 
it is possible to use multiple Sets on the same page. you are advised to define Sets of the same size if used on the same page.

25 previously defined in the string table (see)
26 in this case the term 'variable' refers to genuine variables in their own right, plC parameters, BIOS, alarms etc.
27  e.g. for a parameter that defines a COOl, hEaT and auTO machine mode it is possible to hide one or more values at uI level even if at plC 

(or application level) there are 3 usage modes
28 note that the array starts from the value (0) whereas when defining Sets the first value is 1, therefore Set(1) corresponds to #Set(0)
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SetparvalCfga0 anaOutTypeEnum use of #SetparvalCfga0()
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CONNECTION paNEl DEFINITIONS

Evolution

the Connection work environment dedicated to developers has various sections for creating and managing 
Evolution devices, as well as for compiling the entire project, e.g. as mentioned in Target 
• creating the plC application using application
• defining the graphical interface of Evolution using userInterface
• compiling the Build project
• downloading the project via Device

the sections (panels) are listed below:

Section
panel /Section 

name

application
panel Description

a /

Toolbar 
(main bar) 

 

this section shows the work tools in the form of icons.
some tools can be selected by means of key 
combinations (shortcuts). 
see relevant chapter for details

B project project (workspace)

the project panel can be used to manage the project and 
one or more Evolution* devices
• from the project you can manage the device network 

(Network list) 
• the various protocols are configured in each device 

- see panel C

a

B C D

E
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Section
panel /Section 

name

application
panel Description

C / Configuration panel
(Edit)

this section contains
•  General project management tab
•  Network list tab

depends on the selected Evolution device 
•  General Evolution configuration tab
in the Evolution device 
• plC for configuration of iec application developed 

with application
• hmI for configuration of user Interface menu
• CaNopen for configuration of corresponding 

protocol
• RS485 for configuration of corresponding protocol
• plugins for configuration of protocols using plug-in

D Catalog Device catalogue
this panel shows all the devices available from the 
catalogue. note: dynamic visibility of devices based on 
selections (e.g. plugins)

E Output messages

this panel shows the messages relating to the 
development of the project (file opening, reading/writing 
errors, status of connection to device, etc.)
Note: the connection to the target device is also visible 
in the bottom right of the screen by means of coloured 
messages (see application download)

*Connection manages one or more Evolution devices
Smart can be inserted in the network as a slave device via RS485

the display of the panels can be set from the drop-down menu view > panel name and the panels can be organised as the 
user wants in terms of size and layout.
Studio saves the last settings made

the panel view > Compiler toolbar  is an icon that is visible or hidden in the main menu
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TO STaRT CONNECTION

Evolution

FIRST STaRT-up

1. click on the launch FREE Studio icon on your desktop
2. click on the FREE Studio Connection icon.

 

1 2

the program appears as shown in the picture:

you can now:
• add a new device to the project
• add/remove a network from the Network list 
existing projects have the extension .con

CREaTING a NEw pROjECT (wORKSpaCE)
to create a new project, simply save the project untitled[1] with a name of your choosing (CTRl+S)
to add a device to the project, click add new device to the project or simply drag and drop the FreeEvolution icon from the 
Catalog panel onto the project name.
you are advised to rename each Evolution device with an appropriate name (the default name is FreeEvolution1, 

1 saving the project creates in your pC a new folder with the chosen name that functions as the workspace
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FreeEvolution2, etc.)
in the workspace you can see the name of the device and the version)[2]

creating a new project CTRl+S adding Evolution to the project
Note example of adding 2 Evolution devices

pROjECT paNEl
each Evolution device has the following resources, which are shown as nodes of the target

colour description what to do Notes

plc plc project
move onto the node and click 

the right mouse button to 
open application

see Getting started 
(application)

Hmi menu for creating pages 
move onto the node and click 

the right mouse button to 
open user Interface

see Getting started (user 
Interface)

canopen*
on-board Evolution serial

as standard

select the mode and add the 
device from the catalogue

always available

rs485*
on-board Evolution serial

models 7500 and expansion 
modules EvE75xx

check availability

plugins**
optional modules available 

separately
check availability

* also available as serials on plug-in module

**e.g. Ethernet plug-in

you can create both plC and hmI from scratch or import existing projects and projects from the catalogue 

plC project
From the panel project > plC node click the right mouse button and select open with Free Studio application
by default you will be prompted to save the project FreeEvolution_n_plC
see application for information on development. to summarise:
• develop the plc code with application
• create parameters and state variables of the plc application
• compile and download application onto Evolution and debug if necessary 
• close application and return to Connection
the saved project .ppjs is located in the Connection folder / workspace 

2 the catalogue can contain multiple Evolutions with different versions
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hmI project
From the panel project > plC node click the right mouse button and select open with Free Studio userInterface
by default you will be prompted to save the project FreeEvolution_n_hmI
see user Interface for information on development. to summarise:
• develop the hmI menu or pages with userInterface
• the parameters and state variables of the previously created plC application link to the menu and will be visible in section 

h of userInterface Target vars & parameters
• check the connection mode, appropriately configuring the connection parameters
• compile the hmI pages and download them onto Evolution
• close userInterface and return to Connection
the saved project .pajx is located in the Connection folder / workspace 

the device will be added to a list (highlighted in yellow)
press the reload device list button to populate the table with the list of devices connected to the hmI project and to use the 
pages remotely if so required

plC Configuration
adding an existing project

hmI configuration 
adding an existing project and reloading devices list

Download project 
use the menu Tools>Build or F7 to create the .CFN configuration file
From the panel Tools > Open with Free Studio Device, open Device
after configuring the device, e.g. the BIOS communication parameters, you will be able to download:
• plC application
•  hmI pages
• configuration file Cfg files
using the Download all button 
Note: each of the 3 files can be downloaded independently from the other two by moving the mouse pointer onto the 
respective icon, clicking the right mouse button and running the corresponding download.
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ElIwEll SuppORT

ElIwEll TEChNICal SuppORT

eliwell provides access to fully trained, professional technical personnel to answer its customers' questions precisely and 
reliably. 
our technicians are on hand every day, to respond to any technical requirements relating to the installation and operation of all 
eliwell instruments. 

if you have any questions or require support, contact eliwell technical support:

tel.  +39 0437 986 250
e-mail:  eliwell.freeway@invensys.com

before contacting eliwell technical support please check the software version of eliwell FREE Studio.

From the drop-down menu select help > about
the following screen appears[1]:

Quote software version, build and computer id

ONlINE hElp

during each program development stage, pressing the F1 key opens a pdf document containing the entire online Help in 
printable format 

PR
O

G
R

A
M

M
A

B
LE

 C
O

N
TR

O
LL

ER
S

STUDIO

Development software for free Smart

The software solution in an integrated suite for quick, easy programming Help On Line

FREE Studio offers developers on-line Help to assist programmers with each stage of program development

1 Example for application. Same screenshot for Device. For Evolution users, the screenshot is the same for userInterface and Connection.
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ONlINE hElp - lED[2]

From the panel project>Resources>help access the section lED reference for the developer[3] which contains a description 
of the characteristics of the icons used in FREE Smart and how to manage them using target variable syslocalleds[])

wEBSITE RESTRICTED aREa
the eliwell website www.eliwell.it includes a restricted area, access to which is by password only.

once accredited to access the restricted area with a personal username and password, users can view documents, information, 
product updates and software which is not openly visible on the site.

click here to visit the respective web page and obtain all the necessary information for registering

the Free studio documentation is available to registered users in the section applications > programmables > FREE way > 
FREE Studio

software updates are available to registered users in the section Technical Support > programmables area > FREE way > 
FREE Studio

2 only available for Smart.
3 see full screen (CTRl+u)
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TROuBlEShOOTING
the tables below show some examples of error messages and the corrective action to be taken.
For messages not shown here, contact eliwell technical support or consult www.eliwell.it

applICaTION

Error message panel Effect Resolution

communication target not connected check settings of com port 
using drop-down menu 

communication > settings
ewdmi properties

invalid memory image file.
please upload memory 
image from the target

output compilation error
connect FREE Smart target 
device to pc by means of 

dmi

DEvICE

Error message panel Effect Resolution

invalid connection string connection status target not connected

check communication 
settings using menu 

communication > settings
ewdmi properties or by 
changing string in menu 

communication > advanced
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the table shows some of the key combinations (shortcuts) available for enabling/disabling the main functions of application. 
For Device see next table and/or notes column.
Connection and user Interface have shortcuts for opening, saving and compiling projects
the ‘toggle’ function indicates that the function is enabled if disabled and vice versa by using the same sequence of keys.
For example: ctrl+u enables Full screen; pressing ctrl+u disables it again[1]

the online Help is activated using the F1 key

menu Function Function Shortcut Notes

all ONlINE hElp hElp F1
alwayS avaIlaBlE

printable hElp in 
pDF format

applICaTION ShORTCuTS 

menu Function Function Shortcut Notes

edit print print ctrl+p ***

edit cut cut ctrl+x ***

edit copy copy ctrl+c ***

edit paste paste ctrl+v ***

edit save save ctrl+s ***

view > toolbars
Full screen Full screen ctrl+u toggle***

view > toolbars
Fbd
bar

Fbd bar ctrl+d toggle

view > toolbars ld bar ld bar ctrl+a toggle 

view > toolbars sFc bar sFc bar ctrl+Q toggle

view > toolbars project bar project bar ctrl+j toggle

view > toolbars network networK ctrl+m toggle

view > toolbars document bar document bar ctrl+n toggle

view > tool windows workspace worKspace ctrl+w toggle

view > tool windows output output ctrl+r toggle***

view > tool windows library library ctrl+l toggle

view > tool windows watch window watcH window ctrl+t toggle***

view > tool windows asynch graphic window
asyncH GrapHic 

window
ctrl+K toggle***

project compile compile F7
if more than one 
project, compiles 

only selected project

communication download code download code F5

debuG add symbol to watch
add symbol to 

watcH
F8

when variable is 
selected 

(drag & drop not 
necessary)

debuG inserts new items into watch
inserts new items 

into watcH
sHiFt + F8 chosen from a list

1 in Device, the display of the panels is defined by the view menu, by checking individual headings or leaving them unchecked

ShORTCuTS
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menu Function Function Shortcut Notes

debuG
add symbol to a 
debuG window

F10

debuG
inserts new items 

into a debuG 
window

sHiFt + F10

debuG
add/remove 
breaK point

F12

debuG
add/remove 
text triGGer

F9

debuG
add/remove 

GrapHic triGGer
sHiFt + F9

debuG remove all triGGers
ctrl+sHiFt + 

F9

debuG trigger list ctrl+i

*** also applies to Device

DEvICE ShORTCuTS

menu Function Function Shortcut Notes

edit print print ctrl+p ***

edit cut cut ctrl+x ***

edit copy copy ctrl+c ***

edit paste paste ctrl+v ***

view > toolbars
Full screen Full screen ctrl+u toggle***

view > tool windows output output ctrl+r toggle***

view > tool windows watch window watcH window ctrl+t toggle***

view > tool windows asynch graphic window
asyncH GrapHic 

window
ctrl+K toggle***

parameters read selected read selected ctrl+sHiFt+r the selected 
parameters are 

highlighted in yellowparameters write selected write selected ctrl+sHiFt+r

parameters select all select all ctrl+a

operation to be 
performed with care
the next operation 
could be writing all 
parameters and/or 

resetting the default 
values

*** also applies to application
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Evolution

uSER INTERFaCE ShORTCuTS

menu Function Function Shortcut Notes

conFiGurator bar new project new project ctrl+n ***

conFiGurator bar open project open project ctrl+o ***

conFiGurator bar generate code (compile)
Generate code

(compile)
F7

*** also applies to Connection

CONNECTION ShORTCuTS

menu Function Function Shortcut Notes

main bar new project new project ctrl+n ***

main bar open project open project ctrl+o ***

main bar save save ctrl+s

*** also applies to user Interface
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appENDIX - pROjECT DEvElOpmENT EXamplES

pROjECT 1 - COuNTER

in the pages that follow, we will guide you through the procedure for writing, testing and downloading to FREE Smart a simple 
counter program written in st language, which performs a count and displays a 'saw-tooth' on the oscilloscope.

the counter program counts the local variable a from 0 to maxscale1. when a reaches maxscale1 it will be re-initialised 
to -100.

as previously described in First Start-up,  
• start application, 
• create a new COuNTER project
• create a COuNTER program in ST language

in the central Edit section, write the COuNTER program code in ST language.

COuNTER program

if a>MAXSCALE1 then

a:=-100;

else

a:=+1;

b:=a*10;

end_if;

count:=a;

counter1:=b;

local variables
in the variables section we create the dint type local variables a and b (use the drop-down menu variables > Insert, or the 
icon Insert record) and associate the Init value 0 (zero)
the variables a and b are of no use outside the counter program, and are therefore defined as local

variables and global constants
in the program, we have also included a constant which we will define as ‘global’:
• the constant maxscale1 must be created in the panel project >Global  variables Constants, which we will create here 

in the same way as we create a local variable. maxscale1 has a preset value of -100 so it is not necessary to define it as a 
variable but as a constant

Global shared variables
should you want to display the result of the counter on the target, in the program we have also included 1 variable which we 
will define as Global shared[1]:
the variable count, which we will create, is obtained from the panel Resources>modbus Objects > Status variables and not 
from the section edit/variables, when we enter a new record.
in this case it will be necessary to also define how the name of the variable will appear on the FREE Smart 7-segment display 
(e.g. label of up to 4 digits, for example CNT for count) and mapping between application Type and Device Type

in the counter program we have included another variable, counter1,[2] which we will define in the same way.
in this case, we do not define how it appears on the display. the software will propose COun by default (instead of counter), in 
other words it will use the first 4 letters on the 4-segment display.

1 note that the folder 'Global shared' appears if, and only if, we define the variable in the tab Resources>modbus Objects > Status variables

2  note that if we had created a variable counter and not counter1 at the compilation stage, we would have had an error 
(name conflict between COuNTER program and variable)
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Fundamental state display
by clicking on Resources>FREE Smart we choose what to show as the fundamental state display[3]

we choose the variable count (which is the value of the local variable 'a')
we update the program by entering an always active or always inactive alarm

if alarm then

alarm1:=0;

else

alarm1:=1;

end_if;

the alarm variable must be defined as a local variable - of bool type (boolean). 
FalSE is proposed by default as the initial value - to change it simply key in TRuE. 
the alarm will be always active. we can enter a description such as 'alarm always active'
alarm1 must be defined in the panel resources>alarms. as a label we enter alm1

menu creation
at this point we can create 
• the customised menu prG1 for entering any parameters defined by the developer (or use the existing bios parameters)
• the customised menu set1 for entering the 2 variables count and counter1

Task
if we go back to the project tab and select the task timed we can add the program counter.

Compilation
we compile the project - drop-down menu project >Compile (or F7)
Note: the project is compiled without errors and without the need to use a FREE Smart connected to the pc

To summarise...
... see screenshots

COuNTER program - project tab COuNTER program - Resources tab 
fundamental state display

COuNTER program - Resources tab 
define variables

3 as you can see, the choice includes the default I/O + the variables created by the developer
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COuNTER program - Resources tab
Set menu (SET1)

COuNTER program - Resources tab
alarms menu

COuNTER program - Resources tab
definition of variables

Notes
in the project tab, the global shared variables appear only after they have been declared in the resources tab. in the example:
• alarms  alarm1
• parameters par1
• variables  count and counter1

Connecting to FREE Smart and downloading the application
after connecting Free smart to the dmi and pc on the usb port and making the appropriate checks on the com and baud rate 
(see relevant chapter) we can connect to the target:
• from the drop-down menu Communication > Connect or icon Connects to the target connect to FREE Smart
• if connection is successful, the message connected appears in green at the bottom right of the screen[4]

• from the drop-down menu Communication > Download code (F5) or icon Code download now download the 
application to FREE Smart

• one or more dialogue boxes[5] will appear, indicating that the application will be downloaded. downloading could take a 
few seconds

IEC application already on target 
confirm to continue

plC to be reset confirm replacement application download in progress

The application is not operating on FREE Smart

4 should this not be the case, see Download on target or Troubleshooting
5 depending on whether the target has already been programmed or not
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watch and Oscilloscope

on the display of the target device, the count value appears[6] which ranges from -100 to +100.
note that the alarm led appears because the alarm is active
in the status menu, we can check for the presence 
• of the folder set1 with the variables cnt and count
• of the folder al with the alarm alm1 to 1

on application we can test the value of the variables and display them as text or graphics simply by dragging the variable from 
the code in the panel watch and Oscilloscope
see screenshot below

• note how the local variables a and b cycle from -100 to 100 (x 10 for variable b), as do the corresponding variables count 
and counter1

• alarm is an always true boolean variable (true shown in red[7]) and alarm1 is fixed at 1
• the variable count is displayed in the oscilloscope and we can see the 'saw-tooth'

Saving the project
we can save the project as counter.ppjs or a name of our choice, generate an .rsm file, password-protect it and export it as a 
library object (.pll)

DEvICE

the project can be opened with Device:
we open the tool of the same name, from which we can read or write one or more bios parameters, change them and/or 
download the default again. 
it is possible to read the current value of the variables defined by the developer but not change them

Device does not require the user to know any programming language; the source code is not visible. 
Device requires you to connect to the target device again (click on the respective icon). the central panel shows the protocol 
references, address, etc. the default name of the target device is Freesmart_1[8].
when the target device is connected, you can read the parameters or write the default or changed parameters

6 count is set as a fundamental display. If you do not set any variable, the message plC appears.
 By pressing F5, FREE will appear and you can access the variables and parameters of BIOS
7  if you change alarm from TRuE to FalSE, re-compile and download the new application, the alarm lED will switch off and the variable will be 

indicated in green in the watch panel
8  by simply using the copy/paste function, you can create a twin project FREESmart_2, change the BIOS parameters and download them to the 

target device or a second target device
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Reading parameters 

suppose we cannot read all the parameters (read all device parameters)

as we can see, there are configuration parameters which have default values other than those present on the target device 
(highlighted in blue)

Displaying variables 
as with application, with Device it is also possible to display the variables simply by dragging them to the watch and 
oscilloscope panels

writing parameters 

suppose we want to download all the cl parameters (local bios) and no others. 
select all the parameters - drop-down menu parameters>Select all (ctrl+a) or using the respective icon . the parameters 
are all highlighted in yellow.  write drop-down menu parameters>write selected (ctrl+sHiFt+w) (or using the icon w)
all the cl parameters will be downloaded to the target device

 

CF Folder
parameters CF31 and ui26 with 
different default values from the 

application

watch / Oscilloscope variables count 
and counter1

Cl parameters (all) download in 
progress

we can save the project as counter.cFn or a name of our choice
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pROjECT 2 - COuNTER2 FuNCTION BlOCK

starting from the counter program described in the previous example, we create a function block and we modify the iec 
application by adding code for the switching of a led / relay

Saving the project

we save the counter project by renaming it counter2:
from the drop-down menu File>Save project as proposes the counter work folder.
Go up one level, create a new counter2 folder and save the project as counter2.

Creating a function block

create a new function block COuNTERST in ST language.
copy/paste the counter program into the edit panel of the function block with several variants

COuNTERST program (function block) 

if a>MAX then

a:=-100;

elsif enable then

a:=+1;

end_if;

out:=a;

local input and output variables
in section b[1] variables we create the following variables:
• a as local variable
• maX and enable as input variables to the function block
• out as output variable from the function block
the function block will therefore have 2 input variables, one output variable and one local variable which will save the 
status of the counter in each instance of the function block

1 see application panel Definitions
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we now write the counter2 program in which the functional block will be called.
the function block will have 2 instances CounterSt1, CounterSt2 defined as local variables of counterst type

as we write the code, note how application guides the developer writing the code by proposing the variables to pass to the 
function block[2] 

the boolean variable in this case will serve to switch 
• a suitably configured relay 
• an led[3] of the target on the basis of a defined condition

we now write the new code counter2

COuNTER2 program
CounterSt1(enable:=not Enable_Counter1,MAX:=MAXSCALE1);
counter1:=CounterSt1.out;

CounterSt2(enable:=Enable_Counter2,MAX:=MAXSCALE1/2);
counter2:=CounterSt2.out;

alarm:=(counter1>counter2);

if alarm then

alarm1:=1;
Alarm_relay := TRUE;

else

alarm1:=0;
Alarm_relay := FALSE;

end_if;

if (counter1<=counter2) then
sysLocalLeds[6]:=1;

else
sysLocalLeds[6]:=0; 

end_if; 

2 in the example 2 input variables (identified by an icon with the arrows on the left, and the output with the arrows on the right)

3 we use the variable target sysLocalLeds. See relevant section



FREE Studio - Quick Start  page 71

in the Resources tab, it is necessary to create and/or rename, from the previous project,
the eeprom parameters, status variables, etc.
it is also necessary, if desired, to add the resources to the prg menu and set menu

in the I/O mapping menu, lastly, it is possible to associate resources to the inputs/outputs
we associate a digital input Enable_Counter1 and Alarm_relay to an output

the program is now completed

Exporting to target device
From the drop-down menu Developer>Export application to catalog remember to export the project to catalogue so as to 
enable Device to re-use it for downloading to the target

before exporting to catalogue, use the drop-down menu project>Options to assign to the project a release (e.g. the same 
name counter2), a version (e.g. 1.0) and compile the project again 

this will enable Device to recognise the iec application on the target when it is downloaded

compile the project and download it to target by means of application or Device

the counter will display a count from -100 to 100 in the same way as the iec counter application previously described
in this case, the alarm led will switch to the compressor led[4] once the defined threshold has been reached

4 Syslocalleds[6], The alarm lED is Syslocalleds[16]




